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YAZIM KURALLARI 

 

Amisos Dergisi, yılda iki kez (Haziran-Aralık) yayımlanan ve tüm konferanslarda sunulan 

tebliğlerin metinlerini, bilimsel yenilik getiren, özgün ve nitelikli makalelerini, kazı raporları, 

kitap tanıtımı ve eleştiriler ile haberleri içeren şimdilik İnternet üzerinden yayımlanan 

uluslararası hakemli bir dergidir. 

Dergiye gönderilen makaleler ön kontrol sonrasında uygun bulunduğu taktirde 2 hakeme 

(kör hakemlik) gönderilir. İhtiyaç olması halinde 3. hakeme de gönderilebilir. Gelen 

makaleler alan yoğunluğuna göre makalenin ilk teslim tarihinden sonra çıkacak ilk sayıda 

yayımlanması beklenmemelidir. 

Dergiye gönderilen yazıların, daha önce yayınlanmamış veya bir başka dergiye yayın için 

teslim edilmemiş olmalıdır. 

Dergiye gönderilecek olan yazıların yazar tarafından benzerlik raporu alınmalı ve yazı ile 

birlikte gönderilmelidir. Çalışmanın yayınlanması için benzerlik oranı %20'den fazla 

olmamalıdır. 

Yayımlanması için gönderilen çalışmaların, akademik yazım kurallarına uyularak ve Türkçe, 

Almanca, İngilizce veya Rusça dillerinden biri ile hazırlanmış olması gerekir. 

Yayınlanan her türlü çalışmanın yayın hakkı dergiye aittir. Telif hakkı formu doldurularak 

yazı ile birlikte gönderilmelidir. 

İlgili editör gerekli gördüğü yazım düzeltmelerini kendisi yapabilir. Yabancı dildeki özeti 

yabancı dil editörü gerekli görmesi durumunda düzeltebilir. 

Dergide yayınlanan yazılarda ileri sürülen görüşler yazarlarını bağlar. Yazıların bütün hukuki 

sorumluluğu yazarlarına aittir. Yazarlar, yayın kurulu ve hakemlerin raporlarını dikkate 

almak zorundadırlar. 

Yayımlanan yazılara telif ücreti ödenmez. Amisos, yazarlardan makale değerlendirme ve 

yayın süreci için herhangi bir ücret talep etmemektedir. 

Dergiye gönderilecek bilimsel çalışmalarda araştırma ve yayın etiğine uyum konusunda 

azami dikkat gösterilmelidir. 

 

Yazı Teslim Kuralları 

Amisos Dergisine gönderilen yazılar, Times New Roman, tek satır aralıklı, 12 punto; 

dipnotlar sayfa altında ve 10 punto olarak verilmelidir. Ancak bazı alanların gereği olarak 

yazım esnasında özel font kullanılmış ise, bu fontlar makale ile birlikte gönderilmelidir. 

Gönderilen yazı daha önceden yayınlanmamış ve yayımlanmak üzere herhangi bir dergiye 

değerlendirilmek üzere sunulmamış olmalıdır. 

 

Etik Kurul Onayı 

TÜBİTAK ULAKBİM TR DİZİN’in ilgili kurullarınca alınan kararlara göre 2020 yılı için 

TR DİZİN’de dizinlenen ve değerlendirme aşamasında olan tüm dergilerde yayınlanmak 

üzere başvurusu yapılacak derleme türü dışındaki makalelerin yazarlarından; 
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Etik Kurul izni gerektiren araştırmalar 

• Anket, mülakat, odak grup çalışması, gözlem, deney, görüşme teknikleri kullanılarak 

katılımcılardan veri toplanmasını gerektiren nitel ya da nicel yaklaşımlarla yürütülen her 

türlü araştırmalar 

• İnsan ve hayvanların (materyal/veriler dahil) deneysel ya da diğer bilimsel amaçlarla 

kullanılması, 

• İnsanlar üzerinde yapılan klinik araştırmalar, 

• Hayvanlar üzerinde yapılan araştırmalar, 

• Kişisel verilerin korunması kanunu gereğince retrospektif çalışmalar, 

Ayrıca; 

• Olgu sunumlarında “Aydınlatılmış onam formu”nun alındığının belirtilmesi, 

• Başkalarına ait ölçek, anket, fotoğrafların kullanımı için sahiplerinden izin alınması ve 

belirtilmesi, 

• Kullanılan fikir ve sanat eserleri için telif hakları düzenlemelerine uyulduğunun belirtilmesi 

 

Ayrıntılı Bilgi İçin Linklere Tıklayınız. 

 

https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf 

https://tubitak.gov.tr/sites/default/files/20689/yasal_ozel_izin_belgesi_bilgi_notu.pdf 

 

Sayfa Yapısı: 

Metin boyutu: 12 punto 

Dipnot boyutu 10 punto 

Paragraf aralığ:ı 6 nk 

Paragraf girinti: 1.25 cm 

Üst kenar boşluğu: 2,5 cm 

Alt kenar boşluğu: 2,5 cm 

Sağ kenar boşluğu: 2,5 cm 

Sol kenar boşluğu: 2,5 cm 

Satır aralığı: Tek 

 

Başlık: 

Başlık, makaleyi betimleyici olmalı, makalenin temel kavramlarını, tartışmalarını ve temel 

savını yansıtmalı ve mümkünse 12 kelimeyi aşmamalıdır. Times New Roman yazı 

karakteriyle 12 punto, büyük harflerle ve ortalı olmalı, yazıların ve özetlerin üzerinde, sadece 

yazının başlığı bulunmalı, yazar adı yer almamalıdır. Bir toplantıda tebliğ edilmiş ancak 

yayımlanmamış olan bildirilerde toplantının adı, tarihi ve yeri belirtilmelidir. 

Yazarlar bilgilerini yazı metninde değil dergi sisteminde, isimlerini, tam ve açık kurum 

https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf
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adreslerini, telefon ve faks numaralarını, elektronik posta adreslerini ve ORCID ID'lerini 

bildirmelidirler. Bu bilgiler, hakemlere gönderilmeyecektir. 

 

Öz (Abstract): 

Özet metninin Times New Roman yazı karakteri ile 10 punto ile 150 kelimeden az, 250 

kelimeden fazla olmayacak şekilde hazırlanması gerekmektedir. 

Anahtar Kelimeler: Kelime 1, Kelime 2, Kelime 3, Kelime 4, Kelime 5 (En az 5 kavram 

olmalıdır.) 

 

Abstract:  

Dergimizde yayımlanacak her makalede bulunması zorunlu olan İngilizce özet (Abstract) 

için de yukarıda verilen kuralların uygulanması gerekmektedir. 

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5. (En az 5 kavram olmalıdır.) 

 

Ana metin 

Times New Roman yazı karakteri ile 12 punto ile tek satır aralığında yazılıp, paragraf 

girintisi 1.25 cm ve önce 0 nk sonra 6 nk paragraf boşluğuna göre düzenlenmelidir. Metin 

içinde vurgulanması gereken kısımlar eğik harflerle (italik) yazılmalıdır. 

 

Alt Başlık 

Makalede Times New Roman yazı fontu, 12 punto kullanılmalıdır. Ancak bazı alanların 

gereği olarak yazım esnasında özel font kullanılmış ise bu fontlar makale ile birlikte sisteme 

yüklenmelidir. 

Makalelerde kullanılacak kısaltmalarda TDK Yazım Kılavuzu esas alınmalıdır. 

 

Resimler, Çizimler, Grafikler: 

Fotoğraflar, bilgisayar yazılımlarında oluşturulmuş görsellemeler, vb. resim olarak, ister elle 

ister yazılımlarda çizilmiş teknik resimler çizim olarak adlandırılmalıdır. Bunlar haricindeki 

diğer görseller de uygun bir adlandırma ile (örneğin; harita, şekil, grafik) 

değerlendirilmelidir. Resim, çizim, harita, şekil ve grafikler ardışık olarak 

numaralandırılmalıdır. Bunlara metin içinde (Res. 1), (Şek. 1), (Grafik 1) şeklinde atıfta 

bulunulmalıdır. Her bir görsel için uygun bir kısa tanım kullanılmalı ve tanım görselin altına 

numarasıyla birlikte yazılmalıdır; ayrıca görsel bir başka kaynaktan alındıysa kaynak 

bilgisine de yer verilmelidir. Görsel malzemenin çözünürlüğü en az 300 pixel/inch, uzun 

kenarı en az 15 cm, tam sayfa kullanılacak bir fotoğraf ya da çizim söz konusu ise en az 22 

cm olmalıdır. 

 

Tablolar: 

Tablo başlıkları tablonun üstünde-ortada, diğer şekil, harita vb görsellerin başlıkları altında-

ortada olmalıdır. 

Tablolar da ardışık olarak numaralandırılmalıdır. Tablolara metin içinde numaralarıyla (Tab. 

1) şeklinde atıfta bulunulmalıdır. Her bir tablo için uygun bir başlık kullanılmalı ve bu başlık 

tablonun altına numarasıyla birlikte yazılmalıdır. Örnek: Tablo 1: Çanak çömleklerin 
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merkezlere göre dağılımı. Tablo başka bir kaynaktan alındıysa tablonun sol alt köşesinde 

belirtilmelidir. Örnek: Kaynak: 1983 tarihli ve 2863 sayılı Kanun Hükmü. 

 

* Bu biçimsel özelliklere göre düzenlenen makaleler sayfa sınırlaması olmamakla 

beraber 30 sayfayı aşmamasına özen gösterilmelidir. 

 

DİPNOT VE KAYNAK GÖSTERİMİ 

Dipnotta Sayfa Altında Başka Eserlere Yapılan Atıflar (Times New Roman, 10 Punto) 

• Yazar soyadı, yıl ve sayfa kullanılarak “Yazar 1999, 113” şeklinde yapılmalıdır. 

• İki yazarlı eserlerde iki yazarın soyadı “Yazar-Yazar 2000, 120” şeklinde kullanılmalıdır. 

• Daha çok yazarlı eserler, yalnızca ilk yazarın soyadı verilerek “Yazar vd.” şeklinde ve yine 

benzer biçimde yıl ve sayfa numarası yazılarak kullanılmalıdır. 

• Atıfta bulunulan eserler Kaynakça bölümünde ilk yazarın soyadına göre alfabetik liste 

olarak sıralanmalıdır. 

• İlk yazarı aynı olan eserlerde sıralamayı belirlemek için sırasıyla ikinci ve daha sonra gelen 

yazarların soyadları kullanılmalıdır. 

• Tüm yazarları aynı olan eserler yılına göre eskiden yeniye doğru sıralanmalıdır.  

• Tüm yazarları ve yılları aynı olan eserler ise yılın sonuna eklenen küçük harfler 

kullanılarak “1999a” ve “1999b” şeklinde birbirlerinden ayrılmalıdır. 

• İlk yazarı ve yılı aynı olan üç ve daha fazla yazarlı eserler de aynı şekilde ayrılmalıdır. 

• Metnin tümü, ara başlıklar dâhil, son notlar (endnote) hariç, aralıksız olarak yazılır.  

• Metinde dipnotlar, ilgili olduğu sayfada numaralandırılarak verilir; metin sonuna konulmaz. 

 

Kaynakça (Times New Roman, 12 punto): 

• Kaynakçada tüm yazarların soyadları ve diğer adlarının ilk harfleri yer almalıdır. Kaynaklar 

aşağıdaki örneklere uygun olarak yazılmalıdır. 

• Kaynakçada aynı yazarın çok sayıda kaynağı varsa, kaynaklar eskiden yeni tarihe doğru 

sıralanarak yazılır. Aynı tarihli kaynaklarda harf ile sıralama yapılır. Örneğin: 2000a, 

2000b. 

Dinçol, A.–Dinçol B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten – E. 

Akurgal–H. Ertem–A. Süel (eds.), Hittite and other Anatolian and Near Eastern 

Studies in Honour of Sedat Alp, Ankara, 109-117. 

Karaosmanoğlu, M. 2010, “Yeni Bulgular Işığında Altıntepe Urartu Tapınağı”, XV. Türk 

Tarih Kongresi, I, Ankara, 209-220. 

Öniz, H. 2008, Arkeolojik Sualtı Araştırmacılığına Giriş İçin Eğitim Metodolojisi, Selçuk 

Üniversitesi, Sosyal Bilimler Enstitüsü, Arkeoloji Anabilim Dalı, (Yayınlanmamış 

Yüksek Lisans Tezi), Konya. 

 

Yakar, J. 2003, “Identifying Migrations in the Archaeological Records of Anatolia”, B. 

Fischer–H. Genz–E. Jean–K. Köroğlu (eds.), Identifying Changes: The Transition 
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from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of 

the International Workshop Istanbul, Nowember 8-9, 2002, İstanbul, 11-19. 

Yiğitpaşa, D. 2016, Doğu Anadolu Geç Demir Çağı Kültürü, Ankara. 

 

Internet Kaynakları aşağıdaki gibi verilmelidir: 

URL 1 http://imgkid.com/tibial-fibular-notch.shtml 

 

MAKALELERİN GÖNDERİLMESİ 

Yukarıdaki ilkelere uygun olarak hazırlanmış makaleler, MAKALE GÖNDER SİSTEMİ 

üzerinden gönderilmelidir. E-mail yoluyla gönderilen makaleler dikkate alınmamaktadır. 

"MAKALE GÖNDER SİSTEMİ"nden makale göndermek için: 

* ULAKBİM/DergiPark’a üye olduktan sonra, kullanıcı adı (sisteme kaydedilen e-mail 

adresi) ve şifre ile sayfaya girilmelidir. 

* Açılan sayfada "makale gönder" bölümü açılarak ilgili boşluklar doldurulmalıdır. 

* Makale word dosyası halinde, yazar bilgileri olmadan sisteme yüklenmelidir. Kör hakemlik 

sürecinin daha sağlıklı yürütülebilmesi için yazarlarımızın bilgilerini paylaşmamalarına 

dikkat etmeleri gerekmektedir. Ayrı bir word dosyasında yazar bilgileri eklenebilir. 

Yazar bağımsız hakem değerlendirmesinin sağlanması 

Başvuruların yazar bağımsız değerlendirilmesi, yazar ve hakem kimliklerinin birbirlerine 

bildirilmemesi için gayret gösterilmektedir. Bu amaçla sisteme dosya gönderen yazar, editör, 

hakem gibi kişilerin metin ve dosyalar ile ilgili aşağıdaki noktalara dikkat etmeleri gerekir.  

Yazarlar metinde adları ve kurumları geçen yerleri silmelidirler. Sayfa altı notları vb yan 

metinler dahil olmak üzere Mikrosoft belgeleri saklanır iken dosya bilgileri içine kişisel 

bilgiler de yazılır. Bu nedenle ya bu kişisel bilgiler belge özelliklerinden bulunup silinmeli, 

ya da aşağıdaki sıra ile belge kişisel bilgi içermeyecek biçimde yeniden kaydedilmelidir. 

(File > Save As > Tools (or Options with a Mac) > Security > Remove personal information 

from file properties on save > Save) (Dosya > Farklı Kaydet > Araçlar > Güvenlik > Kişisel 

bilgileri silerek kaydet > Kaydet) 

PDF dosyalarda da Adoba Acrobat ana menüsünden belge özellikleri seçilerek, yazar adı 

silinmelidir. 
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PUBLICATION INSTRUCTIONS 

 

Amisos Journal is an international peer-reviewed journal that is published twice a year (June-

December) and includes the texts of the papers presented at all conferences, scientific 

innovations, original and qualified articles, excavation reports, book introduction and 

criticism and news. 

Articles sent to the journal are sent to 2 referees (blind refereeing), if deemed appropriate, 

after pre-control. If necessary, it can be sent to the 3rd referee. Incoming articles should not 

be expected to be published in the first issue after the first submission date of the article, 

depending on the field density. 

Manuscripts submitted to the journal must not have been published before or submitted to 

another journal for publication. 

The similarity report of the articles to be sent to the journal should be obtained by the author 

and sent with the article. The similarity rate for the publication of the study should not be 

more than 20%. 

Manuscripts submitted for publication must be prepared in accordance with the academic 

writing rules and in one of Turkish, German, English or Russian languages. 

The copyright of any published work belongs to the journal. The copyright form should be 

filled in and sent with the article. 

The relevant editor can make the spelling corrections he deems necessary. The summary in a 

foreign language can be corrected if deemed necessary by the foreign language editor. 

The opinions expressed in the articles published in the journal bind its authors. All legal 

responsibility of the articles belongs to their authors. Authors must consider the reports of the 

editorial board and referees. 

No royalty fee is paid for published articles. Amisos does not charge any fee from the authors 

for the article evaluation and publication process. 

In scientific studies to be sent to the journal, maximum attention should be paid to 

compliance with research and publication ethics. 

 

Article Submission Rules 

Articles sent to Amisos Magazine, Times New Roman, single line spacing, 12 pt; footnotes 

should be given at the bottom of the page in 10 font size However, as a requirement of some 

fields, if a special font is used during writing, these fonts should be sent with the article. The 

submitted article should not have been published before and should not be submitted to any 

journal for evaluation. 

 

Ethics Committee Approval 

According to the decisions taken by the relevant boards of TÜBİTAK ULAKBİM TR 

DİZİN, among the authors of the articles that are indexed in TR DİZİN for 2020 and to be 

submitted for publication in all journals that are in the evaluation phase; 
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Research requiring the permission of the Ethics Committee 

• All kinds of research conducted with qualitative or quantitative approaches that require data 

collection from participants using questionnaires, interviews, focus group work, observation, 

experimentation, interview techniques. 

• Use of humans and animals (including material / data) for experimental or other scientific 

purposes, 

• Clinical trials on humans, 

• Research on animals, 

Retrospective studies in accordance with the law on protection of personal data, 

Also; 

• Stating that "informed consent form" was obtained in case presentations, 

• Obtaining and indicating permission from the owners for the use of scales, surveys and 

photographs belonging to others, 

• Stating that copyright regulations are complied with for the intellectual and artistic works 

used. 

 

Click on the links for detailed information. 

https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf 

https://tubitak.gov.tr/sites/default/files/20689/yasal_ozel_izin_belgesi_bilgi_notu.pdf 

 

Page structure: 

Text size: 12 points 

Footnote size 10 points 

Paragraph spacing: 6 pt 

Paragraph indent: 1.25 cm 

Top margin: 2.5 cm 

Bottom margin: 2.5 cm 

Right margin: 2.5 cm 

Left margin: 2.5 cm 

Line spacing: Single 

 

Title: 

The title should describe the article, reflect the basic concepts, discussions, and main 

argument of the article and, if possible, should not exceed 12 words. It should be in Times 

New Roman font with 12 pt, capital letters and centered, on the manuscripts and abstracts, 

there should only be the title of the article and not the name of the author. In papers that were 

delivered but not published at a meeting, the name, date and place of the meeting should be 

specified. 

https://tubitak.gov.tr/sites/default/files/20689/ekbn_2020.pdf
https://tubitak.gov.tr/sites/default/files/20689/yasal_ozel_izin_belgesi_bilgi_notu.pdf
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Authors should provide their information not in the manuscript but in the journal system, 

their names, full and open institution addresses, telephone and fax numbers, e-mail addresses 

and ORCID IDs. This information will not be sent to the referees. 

 

Abstract: 

The abstract should be prepared in Times New Roman font with 10 font size, not less than 

150 words and not more than 250 words. 

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5 (There should be at least 5 concepts.) 

 

Abstract:  

The rules given above must also be followed for the English abstract, which is mandatory for 

every article to be published in our journal. 

Keywords: Word 1, Word 2, Word 3, Word 4, Word 5. (There must be at least 5 concepts.) 

 

Main text 

It should be written in Times New Roman font with 12 pt and single line spacing, and the 

paragraph indent should be 1.25 cm and first 0 pt, then 6 nk paragraph spacing. The parts that 

need to be emphasized in the text should be written in italics. 

 

Subtitle 

The article should use Times New Roman font and 12 pt. However, as a requirement of some 

fields, if a special font is used at the time of writing, these fonts should be uploaded to the 

system with the article. 

The abbreviations to be used in the articles should be based on the TDK Spelling Guide. 

 

Pictures, Drawings, Graphics: 

Photographs, computer software visualizations, etc. As drawing, technical drawings drawn 

either by hand or in software should be named as drawing. Other visuals should be evaluated 

with an appropriate naming (eg map, figure, graphic). Pictures, drawings, maps, figures and 

graphics should be numbered consecutively. These should be referred to in the text as (Fig. 

1), (Fig. 1), (Graph 1). An appropriate short description should be used for each visual and 

the description should be written under the image with its number; In addition, if the visual is 

taken from another source, the source information should also be included. The resolution of 

the visual material should be at least 300 pixels / inch, the long edge should be at least 15 

cm, and in the case of a full-page photo or drawing, it should be at least 22 cm. 

 

Tables: 

Table titles should be above-in the middle of the table, under the headings of other figures, 

maps, etc. in the middle. 

Tables should also be numbered consecutively. Tables should be referred to in the text as 

numbers (Tab. 1). An appropriate title should be used for each table and this title should be 
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written under the table with its number. Example: Table 1: Distribution of pottery by center. 

If the table is taken from another source, it should be specified in the lower left corner of the 

table. Example: Source: Act No 2863 of 1983. 

 

* Articles arranged according to these formal features do not have a page limitation, but 

should not exceed 30 pages. 

 

FOOTNOTE AND REFERENCES 

Citations to Other Works Below the Page in Footnote (Times New Roman, 10 font size) 

• It should be made in the form of "Author 1999, 113" using the surname of the author, year 

and page. 

• For works with two authors, the surnames of the two authors should be used as "Author-

Author 2000, 120". 

• Works with more authors should be named "Author et al." By giving only the first author's 

surname. and again similarly by writing the year and page number. 

• The cited works should be listed alphabetically in the Bibliography section, according to 

the surname of the first author. 

• For works whose first author is the same, the surnames of the second and subsequent 

authors should be used respectively to determine the order. 

• Articles with the same authors should be listed according to their year from old to new. 

• The works with the same authors and years should be distinguished from each other as 

"1999a" and "1999b" using the lower case letters added to the end of the year. 

• Works with three or more authors with the same first author and year should be separated in 

the same way. 

• The entire text, including subheadings, excluding the endnote, is written continuously.  

• Footnotes in the text are given by numbering on the relevant page; it is not put at the end of 

the text. 

 

Bibliography (Times New Roman, 12 pt.): 

• The bibliography should include the surnames of all authors and the first letters of their 

other names. References should be written according to the examples below. 

• If there are many references of the same author in the bibliography, the references are 

written in order from the old to the new date. The sources with the same date are listed by 

letter. For example: 2000a, 2000b. 

Dinçol, A.–Dinçol B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten – E. 

Akurgal–H. Ertem–A. Süel (eds.), Hittite and other Anatolian and Near Eastern 

Studies in Honour of Sedat Alp, Ankara, 109-117. 

Eker, F., “Antikçağın Süsü: Kahramanmaraş Müzesi’ndeki Kaburgalı ve Burma Cam 

Bilezikler”, TÜBA-AR, 25, 163-171. 

Karaosmanoğlu, M. 2010, “Yeni Bulgular Işığında Altıntepe Urartu Tapınağı”, XV. Türk 

Tarih Kongresi, I, Ankara, 209-220. 



249                                                                                             Yazım Kuralları / Publication Instrutions                                                                     

Öniz, H. 2008, Arkeolojik Sualtı Araştırmacılığına Giriş İçin Eğitim Metodolojisi, Selçuk 

Üniversitesi, Sosyal Bilimler Enstitüsü, Arkeoloji Anabilim Dalı, (Yayınlanmamış 

Yüksek Lisans Tezi), Konya. 

Yakar, J. 2003 “Identifying Migrations in the Archaeological Records of Anatolia”, B. 

Fischer–H. Genz–E. Jean–K. Köroğlu (eds.), Identifying Changes: The Transition 

from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of 

the International Workshop Istanbul, Nowember 8-9, 2002, İstanbul, 11-19. 

Yiğitpaşa, D. 2016, Doğu Anadolu Geç Demir Çağı Kültürü, Ankara. 

 

Internet Kaynakları aşağıdaki gibi verilmelidir: 

URL 1 http://imgkid.com/tibial-fibular-notch.shtml 

 

 SUBMITTED ARTICLES 

Articles prepared in accordance with the above principles should be sent via the 

SUBMISSION SENDING SYSTEM. Articles submitted via e-mail are not considered. To 

submit an article from the " SUBMISSION SENDING SYSTEM": 

* After subscribing to ULAKBİM/DergiPark, you should enter the page with 

username (e-mail address saved in system) and password. 

* In the opening page, the "send article" section should be opened and the related 

spaces should be filled in. 

* The article should be loaded into the system as a word file. In order for the blind 

arbitration process to be carried out better, the authors should be careful not to share their 

knowledge. Author information can be added in a separate word file. 

 

Author independent peer review 

Independent evaluation of the applications of the author, authors and referees are not being 

reported to each other. For this purpose, people who send files to the system, such as authors, 

editors, referees should pay attention to the following points about text and files. 

Authors should delete names and institutions in the text. The page information is also written 

into personal information while the page is stored in the Microsoft documents including sub-

texts etc. Side texts. Therefore, either these personal information must be found and deleted 

from the document properties, or the document in the following order should be re-recorded 

so that it does not contain any personal information. (File> Save As> Tools> Security> 

Delete Personal Information> Save) 

 

In PDF files, the author name should be deleted by selecting document properties from the 

Acrobat main menu. 

http://imgkid.com/tibial-fibular-notch.shtml

